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Overview
Scenario Analysis 123 allows you to quickly create and iterate through several what-if scenarios
using different driver-based rules to analyze different outcomes. The solution lets you create and
manage rules and run calculation jobs across scenarios, and includes reporting capabilities so
you can compare results across scenarios.

Important Usage Considerations
This topic identifies some considerations for best implementing and using Scenario Analysis 123.

Access
Scenario Analysis 123 is not intended for use in Workflows and must only be accessed using the
OnePlace dashboard. Limit usage of Scenario Analysis 123 to the following:

l Experienced OneStream “Power Users”

l Administrator security role

l Security group with a limited number of experienced “Power Users”

Performance Impacts
Scenario Analysis 123 is not intended for full Entity or multi-Entity hierarchy consolidations
spanning multiple periods or years for multiple users. Calculation jobs created using Force
Consolidate are intended for base level calculations and small consolidation hierarchies.

The single environment shares resources between the two applications. Testing Scenario
Analysis 123 in a single environment that includes Development and Production applications will
impact both applications. Coordinate an optimal testing window within your organization to
prevent negative impact on other reporting processes performed in the Production application.

When copying base data from one scenario to another, it is important to understand how much
data is being copied and whether you need to consolidate the whole Entity structure or multiple
Entity structures. Multiple large consolidations in the systemmay impact each other depending on
the environment configuration.

Refer to the consolidation schedules of your organization before using Scenario Analysis 123.
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Setup and Installation
This section contains important details related to the planning, configuring, and installation of your
solution. Before you install the solution, familiarize yourself with these details.

See also: "MarketPlace Solution Modification Considerations" on page 23

Dependencies
Component Description

OneStream
5.3.0 or later

Minimum Platform version required to install this version of Scenario
Analysis 123.

OneStream
App for
Windows

Scenario Analysis 123 is optimized for the OneStream App for Windows
which has all the functionality as the browser-based version of
OneStream.

Select the Scenario Analysis 123
Development Location
Before beginning installation, decide whether to build the solution directly in the Production
OneStream application or in a separate Development OneStream application. This section
provides some key considerations for each option.

Production OneStream Application: The primary advantage of building the solution in a
Production application is that you will not have to migrate the resulting work from a Development
application. However, there are intrinsic risks when making design changes to an application used
in a Production capacity and not advised.

NOTE: OneStream strongly recommends that you implement the solution in the
Development environment with a fresh copy of the Production application before
starting work.

Development OneStream Application: As a best practice, use the Development OneStream
application to build the solution.

Scenario Analysis 123 Guide 2

Setup and Installation



Create the OneStream Development
Application

1. Ensure all the OneStream artifacts relating to Scenario Analysis 123 such as scenarios are
in the Production application.

2. Copy your Production OneStream application to your Development environment and
rename it. This Development version will be used for your Scenario Analysis 123 project.

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can create and
change data in the additional database tables. If other MarketPlace solutions (such as Specialty
Planning) are already in the application, these adjustments may already exist.

See also: "Solution Database Migration Advice" on page 23

Configure the OneStream Application Server
Be sure that the security group settings include the users who work on and set up the solution
before proceeding.

NOTE: Group settings are applicable to all MarketPlace solutions; it is important to
keep the group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.

2. ClickOpen Application Server Configuration File > Database.

3. Edit the followingOneStream Database Server properties:

l Access Group for Ancillary Tables: Select a group that includes those who will access
records.

l Can Create Ancillary Tables: True

l Can Edit Ancillary Table Data: True

l Maintenance Group for Ancillary Tables: Select a group to edit and maintain tables.
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l Table Creation Group for Ancillary Tables: Select a group who can create tables.

4. Restart Internet Information Server.

Install Scenario Analysis 123
1. On the OneStreamMarketPlace Dashboard, clickMarketPlace > Scenario Analysis 123.

2. On the Scenario Analysis 123 Solution page, select the appropriate Platform version from
Minimum Platform Version.

3. Select the most recent version from Solution Version and then click Download.

4. Log in to OneStream.

5. Click Application > Tools > Load/Extract.

6. On Load, locate the solution package using the Select File icons and clickOpen.

7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.

Scenario Analysis 123 Guide 4

Setup and Installation



Set Up Scenario Analysis 123
The first time you run Scenario Analysis 123, you are guided through the table setup process.

l In OneStream, clickOnePlace > Dashboards > Scenario Analysis 123 > Scenario
Analysis 123.

Create Tables
1. Click Step 1: Create Tables

This step may be necessary when upgrading even if tables are already present. Scenario
Analysis 123 does not drop any tables that already exist but modifies table structures and
adds any new ones if necessary.

2. Click Step 2: Launch Solution to open Scenario Analysis 123.

Package Contents
The Dashboard Maintenance Unit provides the user interface for Scenario Analysis 123 and
includes the required dashboard groups, components, data adapters, parameters and files.
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Home
The Home page contains Setup, Execute, and Analyze.

Scenario Analysis 123 is grouped into these sections:

l Setup: Establishes the creation and maintenance of scenario definitions, rule sets, and
rules.

l Execute: Contains execution and management of calculation jobs for scenario definitions.

l Analyze: Displays charts and pivot grids to view different scenario results.

Scenario Analysis 123 Guide 6

Home



Settings
The Settings page contains the Global Options tab where you can set properties to
determine administration and uninstall options.

Global Options
Visit the Global Options page to start configuring Scenario Analysis 123.

NOTE: All Global Options settings are retained during an upgrade.

Access and Manage Scenario Analysis Security Role
Scenario Analysis 123 security is governed at the global level. Therefore, it is the assignment of
the user group to the security role that determines who will be the global Scenario Analysis 123
Administrators.

Assign User Group to Security Role
l ClickGlobal Options, select the user group from the drop-down list (the default value is
Administrators), and click Save.

Analyze Results Row Limit
Analyze Results Row Limit sets the maximum number of data rows that can be used to display the
charts and pivot grids on the Analyze page. The default value is 50,000 rows which can be raised
or lowered to account for server and client hardware-based performance limitations.
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Uninstall
Uninstall lets you remove the user interface or the entire Scenario Analysis 123 solution. If
performed as part of an upgrade, any changes to standard Scenario Analysis 123 objects are lost.

There are two Uninstall options:

1. Uninstall UI removes Scenario Analysis 123, including related dashboards and business
rules but leaves the database and related tables in place. For some releases, this step
should be performed before accepting any new version of Scenario Analysis 123 since
some of the Dashboards or other objects may have been modified.

l Choose this option to update without removing the data tables.

l The Scenario Analysis 123 Release Notes will indicate if an overinstall is supported.

2. Uninstall Full removes all the related data tables, all data, Scenario Analysis 123
dashboards, and business rules. Choose this option to remove Scenario Analysis 123 or to
perform an upgrade, so significant in its changes to the data tables, that this method is
required.

CAUTION: Uninstall procedures are irreversible.
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Setup
Setup lets you create and maintain rule sets, rules and definitions.

Definitions
Definitions consist of a Source and Target scenario for a cube. Rules sets and rules can be
created and applied to the Definition’s Target Scenario.

Name
Freeform text field to give definition a short name.

Description
Optional freeform text field containing additional definition information.

Target Scenario
The scenario to which the rules are applied.

Source Scenario
The scenario that will be copied to the Target scenario.

Cube
The Cube where the Source and Target scenarios are located.

Created By
The name of the user who created the definition.

Created Date
The date the definition was created.

NOTE: Cube and Source scenarios are displayed based on the user’s security
access.
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Click Create to create a Target scenario by copying all Dimension Library properties and settings,
including security settings, from the Source scenario in the same cube.

Create a Definition
TIP: Selecting a Scenario Type should be considered and based on business
requirements. A new Scenario Type can be used if your requirements do not require all
financial model rules to be attached to that Scenario Type.

1. On the Setup page, click Create.

2. In the Create Definition dialog, select the following:

l Definition Name: Enter a display name to identify the definition.

l Definition Description: Enter an optional description for the definition.

l Cube: Select the cube where the Source and Target scenarios reside.

l Source Scenario: Select the Source scenario to copy to the Target scenario.

l Target Scenario Type: Select the new Target scenario type (defaults to the same type as
the selected Source scenario).

l Target Scenario Name: Enter the new Target scenario name where the rules will be
applied.

l Target Scenario Description: Enter an optional description for the new Target scenario.

l Select Copy All Rule Sets and Rules from Source to copy existing scenario analysis
definition rule sets and rules that exist for the source scenario. This will not copy member
formulas and business rules.

3. Click Save.

IMPORTANT: The settings of the Source scenario and Target scenario must be the
same. For example, copying from a Source scenario using Range to a Target scenario
using Yearly is not recommended.
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Delete a Definition
1. On the Setup page, select the definition.

2. Select Delete Row(s).

3. Click Save.

NOTE: Deleting a definition does not delete the Target scenario created with the
definition. To delete a scenario, use the Dimension Library under Application.
Remove the scenario with a Data Management “Clear Data” job beforehand.
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Rule Sets
Rule sets are a collection of rules you can apply to the Target scenario definition.

Name
Freeform text field to give rule set a short name.

Description
Optional freeform text field containing additional rule set information.

Process Sequence
The order in which the Rule Sets are run. Rule Sets are run in ascending order of the process
sequence.

Active
Indicates if the rule set should be run during rule processing (on/off toggle).

Collapse Data
Collapses all data to the Import origin.

NOTE: Use Collapse Data if the scenario will be used in cube view forms to allow
form adjustment entry into the origins.

Add a Rule Set
1. On the Setup page, select the definition.

2. Select Insert Row on the Rule Sets table header and then double-click these cells to enter
information:

Name
Enter a display name to identify the rule set.

Description
Enter an optional description for the rule set.

Process Sequence
Enter the sequence order for rule set processing.

3. Click Save.

Copy a Rule Set
You can copy a rule set across definitions.
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1. On the Setup page, select the definition.

2. Select the rule set you want to copy.

3. Select Copy Set.

4. In the Copy Rule Set dialog, add the new rule set name, a description and the target
definition.

5. Click Copy.

Delete a Rule Set
1. On the Setup page, select the definition and rule set.

2. Select Delete Row(s).

3. Click Save.

Rules
Rules are a collection of percentage values tied to a specific dimension and a time range for a
given definition rule set.
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Name
Freeform text field to give the rule a name.

Description
Optional freeform text field containing additional rule information.

Process Sequence
The order in which the rules are run. Rules are run in ascending order of the process sequence
within each rule set.

NOTE: Consider how to sequence and process rules. Rules with broader to more
specific member filters should be sequenced in ascending order.

Active
Indicates if the rule should be run during rule processing (on/off toggle)

Dimensions (Entity – UD8)
The dimensions available where member filters can be applied for the definition.

Origin
There are three options for origin: Top, BeforeAdj, and Import.

NOTE: Each dimension field is freeform so a member filters can be applied to filter
data. Brackets are added to all member filters when applied to the formula in case a
dimension member has a space. Example: [New York]

See the Cube Member Filters section in the Design and Reference Guide for details.

Periods (P1-P24)
Time periods 1 through 24 where the rule numerical percentage values will be applied.
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Add a Rule
1. On the Setup page, select the definition and rule set.

2. Select Insert Row on the Rules table header and then double-click in these cells to enter
information:

Name
Enter a display name to identify the rule.

Description
Enter an optional description for the rule.

Process Sequence
Enter the sequence order for the rule processing.

Dimensions (Entity – UD8)
Enter the member filters for each dimension.

Periods (P1-P24)
Enter the percentage values for each period. Alternatively, the percentage value can be
entered in the % Value field for a percentage value to be applied to all periods.

3. Click Save.

The % Value field can be used to apply a percentage amount to all periods.

TIP:When creating a new definition, only the settings are copied from the Source
scenario to the Target scenario. If the data needs to be copied to the Target scenario,
apply an All or Root.Base member filter to each dimension in a rule. For example,
A#Root.Base, A#ALL.

Copy a Rule
You can copy a rule to the same or another definition rule set.

1. On the Setup page, select the definition and rule set.

2. Select the rule to copy.

3. Select Copy Rule.
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4. In the Copy Rule dialog, add the new rule name, an optional description, target definition
and target rule set.

5. Click Copy.

Delete a Rule
1. On the Setup page, select the definition and rule set.

2. Select the rule.

3. Select Delete Row(s).

4. Click Save.

Apply a Formula to a Target Scenario
Once rule sets and rules are created, the underlying member filters and percentage values can be
applied to the Target scenario member formula.
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The Apply action adds the member filters and percentage values from each rule to the
Target scenario member formula.

IMPORTANT:When changing rule sets or rules, click Apply to implement changes.

When the formula is applied the message, Formula Generated by Scenario Analysis 123 is added
to the Formula text along with the data and time stamp of update to the Target scenario member
formula in Member Properties.
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Execute

Execute lets you manage and run calculation jobs for scenarios.

Calculation Jobs
Calculation jobs let you execute a Force Consolidate or Force Calculate data management job for
a defined set of data in a definition scenario.

Entity
Where a member filter can be applied to execute the calculation job for a specific entity.

Cons
Where a member filter can be applied to execute the calculation job by a specific consolidation
type.

Calculation Type
The type of calculation, Force Consolidate or Force Calculate.

NOTE: Consider the level in the Entity hierarchy. Each calculation job should only
Force Consolidate or Force Calculate for the relevant data set required. For
example, use Force Calculate when there are no parent members, all base, or just
one base entity.

Start Period
The starting period for the calculation job.

Periods
The number of periods the calculation job should be executed.
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Create a Calculation Job
1. On the Execute page, select the definition.

2. Select Insert Row on the Calculation Jobs table header and then double-click in these cells
to enter information:

Entity
Enter the member filters for the Entity dimension.

Cons
Enter the consolidation type

Calculation Type
Select the calculation type of Force Consolidate or Force Calculate.

Start Period
Enter the starting period for the calculation job.

Periods
Select the number of periods the calculation job should be executed.

3. Click Save.

Runs the selected calculation data management job.

NOTE: Make performance considerations before executing calculation data
management jobs against large metadata hierarchies.
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Analyze

Contains charts and pivot grids to view and analyze different scenarios.

Filters
The View and Pivot results are returned when you specify the header filters.

View
Provides a chart and grid so you can analyze variances between source and target
scenarios. Additional Time, Entity, and Account filters are provided.

Scenario Analysis 123 Guide 20

Analyze



Pivot

Provides a pivot grid where you can filter scenario data for a more granular analysis.
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Help & Miscellaneous Information
This page contains additional solution documentation for Scenario Analysis.

Display Settings
OneStream and MarketPlace solutions frequently display multiple data elements for data entry
and analysis. Set your screen resolution to a minimum of 1920 x 1080 to best render forms and
reports.

Package Contents & Naming Conventions
The package file name contains multiple identifiers that correspond with the platform. Renaming
any of the elements contained in a package is discouraged in order to preserve the integrity of the
naming conventions.

Example Package Name: SAM_PV5.3.0_SV100_PackageContents.zip

Identifier Description

SAM Solution ID

PV5.3.0 Minimum Platform version required to run solution

SV100 Solution version

PackageContents File name
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Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution with custom
tables such as this one. The relationship between OneStream objects such as workflow profiles
and custom solution tables is that they point to the underlying identifier numbers and not the
object names as seen in the user interface. Prior to the solution configuration and to ensure the
identifiers match within the development and production applications, the development
application should be a recent copy of the production application. Once the development
application is created, install the solution and begin design. The following process below will help
migrate the solution tables properly.

See also:Managing a OneStream Environment in the Design and Reference Guide.

1. In the production OneStream application, install the solution and create the data tables.
See "Configure the OneStream Application Server" on page 3 for Database Server
Connection settings and installation details.

2. Data tables are created in the OneStream Development application during the solution
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to
the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator
should run the migration assistant.

IMPORTANT: This process may overwrite existing table data in the production
application database if data already exists.

MarketPlace Solution Modification
Considerations
A few cautions and considerations regarding the modification of MarketPlace solutions:

l Major changes to business rules or custom tables within a MarketPlace solution will not be
supported through normal channels as the resulting solution is significantly different from
the core solution.
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l If changes are made to any dashboard object or business rule, consider renaming it or
copying it to a new object first. This is important because if there is an upgrade to the
MarketPlace solution in the future and the customer applies the upgrade, this will overlay
and wipe out the changes. This also applies when updating any of the standard reports and
dashboards.

l If modifications are made to a MarketPlace solution, upgrading to later versions will be more
complex depending on the degree of customization. Simple changes such as changing a
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the
custom database tables and business rules, which should be avoided, will make an
upgrade even more complicated.
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Appendix A: Custom Event Model
The Custom Event model enables you to add customizations to Scenario Analysis 123 that are
retained during an upgrade. Scenario Analysis 123 supports these models using business rules.

Set Up the Custom Event Model
1. On the Application tab click Dashboards > Dashboard Maintenance Units > XFW

Scenario Analysis 123 (SAM) > Files.

2. In Files, click CustomEventHandler_SAM.zip.

3. In the General (File) pane, click Download File and save the file to an appropriate location.

4. On Application, click Tools > Load/Extract.
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5. On Load, locate CustomEventHandler_SAM.zip using the Select File icons and click
Open.

6. When the file name appears, click Load to import the business rule.

Integrate Business Rules
After importing the business rule, update the SAM_EventHandler business rule to integrate with
the CustomEvents business rule.

1. In the General section of the SAM_SolutionHelper script Properties tab, add
BR\CustomEvents_ScenarioAnalysis123 to Referenced Assemblies.

2. In the General section of the SAM_EventHandler script Properties tab, add
BR\CustomEvents_ScenarioAnalysis123 to Referenced Assemblies.
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3. Comment out line 42 of the SAM_EventHelper business rule.

4. Uncomment line 43 of the SAM_EventHelper business rule.

Once the custom event integration is complete, event actions can be defined in the
CustomEvents_ScenarioAnalysis123 script.

NOTE: These events are not deleted or overriden in an upgrade. However, reapply
these setup steps every time a new version is installed.

Available Custom Events
Before/After Selection Changed Events
These events run before/after a custom control is clicked: 

l SaveSettings 

l CreateSolutionTables 

l ValidateSetupStepsExecuted 

l Uninstall 

l OnTableEditorOrGridSelection

l OnComboBoxSelection

l OnButtonClick

l OnShowContentPage

Before/After Save Data Events
These events run before/after the save event for a table editor. For example, this can be used to
test grid data prior to saving and potentially not allowing the data to be saved if a check fails. 
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l OnSaveOrUpdateTableEditor
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